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I.  Getting Started 
 
A.  Purpose 
This document is designed to help people at Ivy Tech Community College format 
papers using Microsoft Word in APA and MLA format.  Note that if you go to 
http://www.ivytech.edu/library/lafayette/librarynews/Citations.htm you can view sample 
papers in APA and MLA that are formatted according to the most recent documenting 
guidelines.  This document will “walk people through” how to manipulate Microsoft Word 
2007, so they may format their papers correctly. 
 
B.  Word Processing Basics 

• Click on the Start  button in the lower left corner of the computer screen 
• Slide your pointer up to All Programs  
• Slide your pointer over to Microsoft Office 2007  
• Slide your pointer over to Microsoft Office Word 2007 and left click on it 
• Microsoft Office Word 2007 should open 
• If a user name box appears, left click OK 
 

C.  Identifying the Home Menu Bar in Microsoft Word 2007 
 
Office Button 
Open, Save and Print  
 
 
 

 
 
Font Name Font Size  Left Align Center Align        Line Spacing            
 
 Italics  Undo previous typed or clicked command 
 
D.  Saving your work 

• You will need either a flash drive or a floppy disk to save your work on an Ivy 
Tech Community College computer.  If you need to purchase one, you may do so 
at the campus bookstore. 

*Other toolbar options are available on each of the 
toolbar headings: Insert, Page Layout, References, 
Mailings, Review, and View. 
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• Put your flash drive into the drive of the computer you are using. (If you need 
help, ask for assistance at the counter in the LRC, the computer lab monitor or 
the person at the library’s information station.). 

• Click on the Office Button  (on the home menu bar at the top of the screen).  
• Select Save As 
• Then you will usually select the default option, which is to save it as a Word 

document. 
• When the dialog box opens, click on the drop down arrow in the “Save in” box (at 

the top of the “Save As” dialog box) and either select (E:) or (F:) for the 
removable drive, flash drive, or select “3 ½” Floppy (A:). 

• In the File name box at the bottom of the “Save As” dialog box type in a name for 
your paper. 

• Click the save button. 
• Note that it is a great idea to save your work twic e (i.e. on two flash drives 

or disks)!  
 
E.  Opening a saved file  

• Start Microsoft Word 2007. 
• Insert your drive or disk into the computer. 
• Click on the Office Button  (on the home menu bar at the top of the screen). 

 
• Click Open. 
• In the “Look in” box, click the drop down arrow and select either the flash drive 

(E:) or (F:) or 3½” Floppy (A:). 
• Click on the file you want to open. 
• Click on the open  button. 
• You can now edit or print your document. 

o If you edit your document, you click on the Office Button . Then select 
Save to replace the original document, or Office Button  then Save As to 
save the file with a new name and keep the original document. 

� When using Save As, a good filename would be to add the number 
2 to the original filename.  

 
Example: Original filename  New filename  

Turning Point.doc  Turning Point2.doc 
 
F.  Printing 

• Click on the Office Button  (on the home menu bar at the top of the screen). 
o Click Print. 
o A dialog box will appear – click OK to print one copy of your document. 
o If you are in the Campus Library, you’ll get a prompt asking you to give 

your print job and name and password. 
� Note that you will need to pay for copies in the LR C and 

computer labs.  You will also need to pay to print at the library. 
At the library, use your student ID to get your fre e Debitek card 



   
   

Ivy Tech Community College – Region 4                APA & MLA Word Processing Page 5 
 

at the circulation desk, add money to the card upst airs, and 
then print. 

 
G.  Quitting  

• To leave the program after printing & saving your document, click on the Office 
Button  (on the home menu bar at the top of the screen).  

• Select Exit Word at the bottom right. 
• Wait until the green or red light by the drive goes out and remove your drive or 

disk and take it with you! 

 
II.  Default Settings 
 
A.  Understanding Default Settings  
Default settings are automatic. 
 
B.  Font type and size  

• Times New Roman, Arial, Calibri are some of the more common font types, and  
10,11, or 12 are usually the default font sizes. 

• The words Times New Roman,  Arial, Calibri or some other font type will be 
displayed.  Most instructors prefer font types that are normal print type not scrip 
or something fancy.  

• If you need to change the font type, be sure that you are on the Home  tab, click 
on the drop down arrow for Font (This is identified on the example toolbar on 
page 3 of this document.) and select your font preference from the list of fonts 
available. 

• Next to the font name is the box for Font Size .  Ten to twelve should the default 
size for type.  You can change this to a larger number for bigger type or a smaller 
number for smaller type. This document is written using Arial 12 point font. 

 
C.  Margins 

• The default setting is  
o Top 1 inch 
o Bottom 1 inch 
o Left 1 inch 
o Right 1 inch 

• To change your margins, 
o Click the Page Layout  tab (on the menu bar at the top of the screen).  

This will open a different tab; there are seven in Microsoft Word 2007. 
o Under the group Page Setup , click on Margins . 
o The Normal  option should be selected for most documents with an 

academic purpose; however, at the bottom of that screen you may select 
Custom Margins .  Then click OK. 
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III.  Variable Settings 
 
A.  Double Spacing 

• Under the Home  tab, go to the Paragraph  group.   
• Click on the Line Spacing. (This is identified on the example toolbar on page 3 

of this document.) 
• Click on the drop down area and select the desired line spacing.  Note that most 

academic papers are double spaced, which is 2.0. 
 

B.  Title Page 
• Set your paper to double space.  
• Go to the Home tab and under the Paragraph  group there is a Center Align 

icon.  (This is identified on the example toolbar on page 3 of this document.)  
Select that icon. 

• Check your assignment’s guidelines to see which format your instructor wants 
you to use—APA or MLA (or something else). 

1. Directions for APA—due to recent revisions in AP A formatting, there are 
two formatting versions here.  Please check with yo ur instructor for his or her 
preference. 
 
This is in accord with Muriel Harris’ Prentice Hall Reference Guide sample on 
page 436. 

o Line one – Running head (title typed in capital letters at top left and is 
usually used for publication purposes) 

o Press the <Enter> key 8 times  
o Type the following: 

� First line – Title  
� Second line – Author’s name (i.e. the person who is authoring the 

paper) 
� Third line – Affiliation (writer’s college) 

o Press the <Enter> key 
 

    This is the traditional format—see note on page 437  in Harris’ text. 
o Press the <Enter> key 9 times  
o Type the following: 

� First line – Title  
� Second line – Author’s name (i.e. the person who is authoring the 

paper) 
� Third line – Instructor’s name 
� Fourth line – Course that the paper is for (ENG 025-01, BUS 101-51 

etc) 
� Fifth line – Date that assignment is due 

o Press the <Enter> key 
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      2. Directions for MLA—see page 401 in Harris’  text. 
o Press the <Enter> key 6 times 
o Type the following: 

� First line—Title 
� Press the <Enter> key 3 times 
� Second line—Author’s name (i.e. the person who is authoring the 

paper) 
� Press the <Enter> key 3 times 
� Third line—Instructor’s name 
� Fourth line-- Course that the paper is for (ENG 025-01, BUS 101-51 

etc) 
� Fifth line – Date 

 o Press the <Enter> key 
• To start a new page and begin typing your paper, hold down the <Ctrl> key and 

press the <Enter> key one time. (This forces the computer to start a new page.) 
 
C.  Typing your paper 

• If you did a title page, you need to turn off center alignment.  To do this, click on 
the left alignment  button.  (This is identified on the example toolbar on page 3 of 
this document.) 

• To indent your paragraph, press the Tab key one time (on the left side of the 
keyboard next to the letter Q). 

• Press the <Enter> key when you want to begin a new paragraph.  DO NOT 
press the <Enter> key at the end of each line.   The program’s word wrap 
feature will send your text to the next line when you run out of room. 

 
D.  Headers & Page numbers  
 • To add automatic page numbers,  

o Go to the Inset  tab and under the Header & Footer  group, click on Page 
Number . 

o Click on either Top of Page  or Bottom of Page  depending on your 
instructor’s preference.  (Note that in both APA and MLA, page numbers 
should be in the upper right hand side.  In APA they start on the title page, 
which is page one.  In MLA page numbers start on page two.) 

o Three boxes should appear on a drop down menu.  Select where you wish 
the page number to appear— left margin, center, or right margin.  (Note 
that in both APA and MLA, page numbers should be in the right margin.) 
 

• If you DO NOT want a page number on your title page, 
o Go to the Inset  tab and under the Header & Footer  group, click on Page 

Number . 
o On the list that opens, select Format Page Numbers 
o Under Page Numbering click Start At  and type in 2 
o Select OK at the bottom of the list 
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• To set up your header, 

o Go to the Inset  tab and under the Header & Footer  group, click on 
Header . 

o Select Edit Header . 
o If you are using APA,  there will be a header on the title page.  Therefore, 

once the header box opens at the top of your paper, push the Tab button 
(on the left side of the keyboard next to the letter Q) two (2) times to move 
the cursor to the right hand margin. 

o Type in your desired header, which is usually an abbreviated form of the 
title of the paper. 

o Next you will need to highlight the header you just typed and right-click on 
the mouse.  A mini-toolbar should open just above your cursor.  Select the 
font type and size that fits with the body of your paper. 

o If you are using MLA,  there will not be a header on the title page, so first 
of all follow the directions for APA with the exception that in MLA you 
should type your last name instead of the abbreviated title.   

o Then you will need to note that upon selecting Edit Header, a new tab 
opened—the Design tab. 

o Under the Design  tab, go to the Options  group. 
o Select the box for Different First Page— this will put a check in the box.  

Selecting this box will make page one header’s blank, and that is correct 
for MLA format. 

• Hit ESC (upper left hand side of the keyboard)  to get out of Headers & Footers 
 

 
E.  Reference page 

It is our advice here at the library that you consu lt NoodleTools, which is an 
online citation generator.  It may be found at 
www.noodletools.com.lafayette.libproxy.ivytech.edu/ login.php   Also there is a 
HELP guide to go along with NoodleTools that may be  found at 
http://www.elms.edu/departments/library/prmaterials /NoodleToolsPamphlet.ht
m#Directions  
 
(The second line of a reference is indented—this is called hanging indentation.) 
• On a new page, click on the center alignment  button. (This is identified on the 

example toolbar on page 3 of this document.) 
• Type the word References for APA format and type Works Cited for MLA format 

at the top of the page (do not bold or underline References), press <Enter >. 
• Click on the left alignment button. 
• Select the Page Layout  tab and go to the Paragraph  group. 
• In the lower right hand corner click on the arrow to open the dialog box for the 

paragraph group. 
• Go to the Indentation section. 
• Under Special  select Hanging.  
• Click the <OK> button. 



   
   

Ivy Tech Community College – Region 4                APA & MLA Word Processing Page 9 
 

• Type your first reference using MLA / APA format. Press the <Enter > key when 
you are ready to begin your second reference. 

• NOTE: If you have a long internet address as part of your reference, the 
computer may move it down to the next line and leave a large empty space on 
the first or second line of your reference. This is OK.  

• For additional information on referencing sources check out the MLA / APA 
Citation Document on the Ivy Tech Virtual Library Writing & Research page. 
http://www.ivytech.edu/library/lafayette/librarynews/Citations.htm, Muriel Harris’ 
text The Prentice Hall Reference Guide and/or Purdue’s Online Writing Lab, 
OWL. 

 
F.  Spell Check 
Note that Word 2007 automatically checks for grammar and spelling errors.  A grammar 
error is indicated by a green wavy line and spelling is indicated with a red wavy line. 

• To make changes to the spelling or grammar error, right-click  the underlined 
text and select from a list of corrections. 

• To check spelling and grammar all at once, click on the Review tab and under 
the Proofing group select Spelling and Grammar  or press F7. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A special “Thank You” to Ceil Sayler of the Ivy Tech - Lafayette campus who allowed 
the use of her Word Processing Document as the basis for this brochure. 


